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Prez Says:

Ron Cowger

Well, here we are in October and ironically the temperature today is warmer than I think it
was on most days during September. Has our local weather been fouled up or what? As I
recall, one of the local weathermen reported a few days ago that only two days in September were categorized as “sunny.” That’s almost enough to make one leave the area for a
break. My wife and I have a short trip to northern California planned for later in the
month. I hope it’s nice while we are down there. Oh well, the cold and wet weather has
given me more time to work on some computer projects that I wanted to get done instead
of working in the yard. I am definitely a fair-weather gardener and the garden shows it.
I really enjoyed the presentation on Office 2010 that Carl gave us at the General Meeting
last month. Microsoft added some handy new tools and made all of the applications
within the Office suite consistent in that they all use the ribbon bar now. I’m still trying to
get used to that. Anyway, I really appreciate Carl giving us some of his precious time.
He’s a very busy guy and we are all grateful when he can get away from his teaching
schedule to join us at a General Meeting. Thanks again, Carl. We learned a lot from your
presentation.
The October presentation will be from Steve Fondren. As many of you know, Steve has
been trying to get through a list of some of his favorite applications and tools that he uses
to troubleshoot and repair computers. Due to many questions and sometimes getting off
track during his SIG that precedes the General Meeting, Steve has not gotten very far into
his list. Therefore, Steve has graciously agreed to be the main presentation speaker at the
General Meeting to ensure that he has time to get all the way through his topic. I’m looking forward to his presentation as I know he has developed the collection of tools based on
working as effectively and efficiently on problems that he encounters during customers’
service calls. This information should be very helpful to most of us. I hope to see each of
you there.
As I announced at last month’s General Meeting, the Board is proposing that we buy vests
as the next KEGS club garment rather than shirts. Most of the members who were at the
General Meeting were receptive to the idea so we are now pursuing that initiative. As I
told you before, we need twenty-four orders for the purchase to be economically reasonable. To date, about sixteen folks have signed up on the order lists. I hope that we can get
twenty four soon so that we can submit the order. I’ll keep you informed as we get more
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Prez Says: continued
participation.
This month there are two new tips from Sharon Parq Associates added to our monthly
newsletter. There is one for using Word and the other for Excel, each designed to expand our knowledge of these applications. If you want access to additional tips from
this company, you can go to their websites at word.tips.net or excel.tips.net. I think
you’ll find the information interesting and useful.
Starting this month, members can renew their KEGS memberships for 2011 and earn
the designation of Early Bird Members. As I think you know, by being an Early Bird
Member you will receive an extra drawing ticket when you check in at the General
Meetings. Renewal forms are available from John Tate, our Treasurer, or you can fill
out the form on the KEGS web site, print it out and send it along with your check to the
address shown on the form. An even easier way would be to bring your completed form
and your check to the next General Meeting and give it to John there.
Also starting in October, we will be looking for members who would like to serve on
the KEGS Board of Directors. I encourage each of you to consider volunteering some
of your time to help run the user group. The Board only meets once a month for less
than two hours so most jobs on the Board don’t take too much of a member’s time. If
you feel that the organization needs some new ideas and fresh faces on the Board,
please volunteer to serve for a year. Just tell any member of the Board that you are interested and he/she will give your name to the Nominating Committee. The Nominating
Committee this year consists of Sally Ann Mowrey, Jerry Olson and me. Thanks for
giving it some thought.
That’s it for now. I hope to see each of you at the General Meeting or at your favorite
SIG. I wish you happy and safe computing!

Ron Cowger
President
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Word Tip of the Month
Searching for Paragraph Formatting
Word has a very powerful search capability that allows you to find not just text but the formatting of
text as well. To search for paragraph formatting, follow these steps:
1.
2.

Press CTRL+F to display the Find tab of the Find and Replace dialog box.
Make sure the Find What box is empty.

3. Click on the More button if it is available.

The expanded Find tab of the Find and Replace dialog box.

4.

Click on the No Formatting button, if it is enabled.

5.

Click on the Format button and select Paragraph. The Find Paragraph dialog box appears.

6.

Select the paragraph attributes for which you want to search. When selecting attributes that
use check boxes, a check in a check box means the matching paragraph must have the attribute. If the check box is empty, then the paragraph won’t have that attribute. A shaded
box means the attribute doesn’t matter.

7.

Click on OK.

8.

Click on Find Next.

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word
tips can be found online at http://word.tips.net.
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Excel Tip of the Month
Controlling the Display of Page Breaks
When you are formatting a worksheet, you may want to see where Excel will insert page breaks in
your printout. This is easily done by using the Print Preview option, or by using the Page Break Preview feature. You may also want to see the page breaks when you are again editing the worksheet.
Excel can display page breaks as dashed lines between rows or columns on your worksheet. To enable
this display, simply follow these steps:
1.

Choose Options from the Tools menu. Excel displays the Options dialog box.

2. Make sure the View tab is selected.

The View tab of the Options dialog box.

3.

Make sure the Page Breaks check box is selected.

4.

Click on OK.

If you are using Excel 2007 or Excel 2010 then the steps to follow are a bit different:
1.

Display the Excel Options dialog box. (In Excel 2007 click the Office button and then click
Excel Options. In Excel 2010 display the File tab of the ribbon and click Options.)

2.

At the left side of the dialog box, click Advanced.

3.

Scroll through the list of options until you see the Display Options for This Worksheet section.
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Excel Tip of the Month—Continued

The Excel Options dialog box.

4.

Make sure the Show Page Breaks check box is selected.

5.

Click on OK.

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel
tips can be found online at http://excel.tips.net.

KEGS General
Meeting

KEGS T-shirts

And Associated SIGs

We still have a few left of various sizes.
Then we will order more. So why wait?
Pick yours up at the next general meeting.

Remember, you score extra KEGABUCK$
when you wear your KEGS shirts to SIGS
and the General Meetings! (NOTE: This
extra credit is not honored at the PIG SIG.)

General Meetings at the Kirkland Teen Union Building - 348 Kirkland Ave., Kirkland, WA 98033
Day of Month

Time

Location

SIG / Email contact

SIG Leader

2nd Monday

6 PM - 7 PM

Kirkland Teen Union
Building

Technology Corner
betacode@hotmail.com

Steve Fondren

2nd Monday

7 PM - 9 PM

Kirkland Teen Union
Building

KEGS General Meeting

2nd Monday

9:30 PM - ?
PM

Outback Steakhouse
Pig SIG
12120 NE 85 th, Kirkland
sallyannmowrey@msn.com

Sally Ann Mowrey
206-996-5635

DRIVING INSTRUCTIONS: From I-405, take the N.E. 85th ST. exit (exit number 18) toward KIRKLAND (headed West). Immediately move to the center lane and take a left at the first light onto
Kirkland Way (If you went right you would be on 114th Ave NE). Just stay on Kirkland Way and it
will turn into Kirkland Ave.
The Kirkland Teen Union Building is part of a string of connected buildings. Right at the street is
Kirkland's Performing Arts Center, then comes the Kirkland Senior Center and farthest from the
street is The Kirkland Teen Union Building.
There is a parking area to the West of this building but you can also park in the Kirkland Library's
covered parking area just a little farther to the West ( 1/4 block past the Performing Arts Center).

KEGS SIG Meetings:
NEW SIG CHART
Notice that this SIG chart no longer lists actual dates. Please check our KEGS calendar (at
http://www.kegs.org/Calendar.html) for actual dates AND POSSIBLE CANCELLATIONS of
the upcoming meeting that you want to attend.
Contact the SIG leaders to find out what presentations that they have planned for their upcoming meetings.

KEGS T-shirts
Remember, you score extra
KEGABUCK$ when you wear
your KEGS shirts to SIGS and the
General Meetings! We still have
a few left of various sizes.
Then we will order more. So
why wait? Pick yours up at the
next meeting.

Meetings at the North Bellevue Community / Senior Center - 4063 148th Ave NE, Bellevue, WA
Day of Month

Time

Location

SIG / Email contact

SIG Leader

2nd Tuesday

7 PM - 9 PM

Conf. room D

Digital Video SIG

Jack Beslanwich
206-723-9960

jackbewitch@comcast.net
1st Wednesday

7 PM - 9 PM

Conf. room D

Seattle Internet User Group

Marianne Wilkins

seasigi@kegs.org
2nd Tuesday

7 PM - 9 PM

Conf. room D

WIN 95/98/XP/??
daviddodge1@compuserve.com

David Dodge

2nd Wednesday

7 PM - 9 PM

Conf. room D

Laptop SIG
ctheprof@aol.com

Carl Von Papp
425-643-1398

3rd Tuesday

7 PM - 9 PM

Computer Lab

Computer Support SIG - N.
j_m_mraz@hotmail.com

3rd Wednesday

7 PM - 9 PM

Conf. room D

Small Office / Home Office
r_cowger@prodigy.net

Ron Cowger

4th Tuesday

7 PM - 9 PM

Conf. room D

Digital Imaging SIG
sallyannmowrey@msn.com

Sally Ann Mowrey
206-996-5635

4th Wednesday

7 PM - 9 PM

Conf. room D

HTML SIG

Jack Beslanwich
206-723-9960

Bellevue

Joe Mraz
425-747-2433

(Computer repair & maintenance)

jackbewitch@comcast.net

SIG Meeting Locations:
Please note that the KEGS Board meetings are not held at our General Meeting or SIG
meeting locations
• KEGS Board Meetings are currently held at Executive Real Estate’s Bellevue office at 20
Lake Bellevue, Bellevue, WA. (Board meetings are public and open to anyone who wants
to attend.)
Finding our primary SIG meeting location
DRIVING INSTRUCTIONS: Thanks to the improvements to SR 520, you may now use the new
NE 40th St exit. If you are driving towards Redmond, exit and turn left to go over the overpass. If you are coming from Redmond, exit and turn right. Go to 148th Ave NE, and turn
right. In very short order, you will see the North Bellevue Community / Senior Center sign on
the left side of the roadway.

History & Contact info:
KEGS was formed in late 1996 to meet the needs of personal computer users in the Greater
Seattle Area. KEGS is a nonprofit organization that holds its general meetings on the second
Monday of each month.
In addition, KEGS sponsors a number of special interest groups (SIGs) that meet regularly
to share common interests, learn new techniques, and resolve questions about the use of personal computer hardware, accessories, or software.
For a detailed listing of our SIG’s, updated information about KEGS activities,
and more, please see our web site at:
http://www.kegs.org.

Contact us at: Email: info@kegs.org
The Komputer Enthusiasts of Greater Seattle
PMB# 195
677 120th Ave NE, Suite 2A
Bellevue, WA 98005

Or call 425-747-2433 before 9 PM

To submit articles or software reviews for incorporation into this Newsletter, please send them
to: newsletter@kegs.org

